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Full Motion Video 
 

ArcGIS Desktop supports capabilities for working with full motion video. These capabilities help a broad 

range of customers visualize and analyze full motion video (FMV), and integrate them with traditional 

GIS datasets and analysis.  

 

This User’s Manual is organized into 7 sections. The first sections address installing the FMV 1.3.1 

Add-In application properly. The next sections focus on usability of the different functional components 

of the FMV Add-In, and address optimum settings and techniques to best exploit the functionality in 

operation environments. This is followed by the Menu Map which contains a list of all the buttons and 

functions contained in the FMV 10.3.1 Add-In. These include the FMV Toolbar, Video Manager, Video 

Player, Metadata Viewer, Properties Viewer, and Geoprocessing tools.  
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System requirements 
 

System requirements 
 

The system requirements for Full Motion Video are the same as the version of ArcGIS Desktop. 
 

 ArcGIS 10.2.x Desktop System Requirements 

 ArcGIS 10.3 Desktop System Requirements 

 ArcGIS 10.4 Desktop System Requirements 

 

Licensing and software requirements 
 

 ArcGIS 10.2.x, 10.3.x or 10.4.x Desktop must be installed. 

 The FMV add-in and geoprocessing tools will work with a Basic, Standard, or Advanced license. 

 Mosaicking requires a Standard or Advanced license.  

 The ArcGIS Full Motion Video Add-In is now available here. Scroll to the bottom of the page 
and either call TeleBusiness or to go to My Esri. 

 Your video stream and files must have metadata that is Motion Industry Standards Board compliant. It 
is highly recommended that you review the latest MISB description which can be downloaded by 
going to http://www.gwg.nga.mil/misb/zip_pubs.html  and downloading the latest Composite 
Documents Zip File > Opening ST0601.9.pdf. 

 You must have installed an extraction utility, such as 7-Zip. You can download 7-Zip for free at 
http://www.7-zip.org/

http://desktop.arcgis.com/en/arcmap/10.3/get-started/system-requirements/arcgis-desktop-system-requirements.htm
http://desktop.arcgis.com/en/arcmap/10.3/get-started/system-requirements/arcgis-desktop-system-requirements.htm
http://desktop.arcgis.com/en/system-requirements/latest/arcgis-desktop-system-requirements.htm
http://www.esri.com/products/arcgis-capabilities/imagery/full-motion-video
http://www.gwg.nga.mil/misb/zip_pubs.html
http://www.7-zip.org/
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Release notes 
 

New Features 

 More efficient video playback, panning and zooming 

 Improved multiplexing giving users the ability to customize bit rate 

 Full support for TIFF and JP2 image format for video mosaics, including full image map 

transformations for more accuracy 

 New geoprocessing tools for mosaicking archived and live video streams, and video frames 

 New Zoom to Frame tool making it easier to find your videos on the map 

 UI Updates 

 Full support for ArcGIS Desktop 10.3.x and 10.4.x 

 New time shift template to be used in the video multiplexer geoprocessing tool. This and the field 

mapping file is in C:\Program Files (x86)\ArcGIS 10.4 Full Motion Video Geoprocessing Tools\Video 

Multiplexer Templates 

 Images from a live stream can be captured and mosaicked. 

Tips and Best Practices 
 

 Recording, mosaicking, time-syncing, and displaying map features on the video are all 

computationally intensive operations. 

 Please keep this in mind when running these operations on multiple videos at the 

same time or when using other computationally intensive ArcMap tasks. 

 Positional accuracy of digitized features declines with increasingly oblique angles of video. For 

best accuracy, digitize over video collected at near nadir or vertical angles (e.g. from as directly 

above as possible). 

 High video frame-to-metadata ratios will typically result in smoother map geometry and more 

accuracy when running full motion video functions, such as digitizing or measuring. 

 To digitize features on a video, start an edit session and use a feature template. 

 
Known Issues 

 
 Bookmarks may need to be clicked more than once in order to zoom to their locations. Each 

additional time a bookmark is clicked a larger search is run for the closest metadata packet 

to the requested frame. This is required because metadata packets may either be in front or 

behind the requested frame. 

 On some systems a video player window may resize very slowly, in small increments. To 

prevent this, activate the Manually resize player windows option from the Video Manager. 

This option is off by default. 

 When playing videos with minimal metadata and using the 'Display features from the map on 

the video' tool features may appear 'choppy'. To prevent this, enable the Check to maintain 

smooth playback option under the General tab of the video properties. This will animate the 

features using a built-in timer for a smoother display. 

 

Existing Features 

 Use the video search capability to create search indexes and perform targeted video searches. 

Search based on location, time, and selected features as filters. Sort search results to create a video 



Using the ArcGIS Full Motion Video 1.3.1 Add-In 

6 Copyright © 1995-2016 Esri. All rights reserved. 

 

 

queue and export clips complete with full metadata. Export search results to share within your 

organization. 

 The Video Multiplexer geoprocessing tool enables users to create motion industry standards board 

(MISB) compliant video data from synchronous or asynchronous video and accompanying IMU data. 

UNIX time stamp values are now displayed across the UI using MISB 0601.5 7.2 Tag 2: UNIX Time 

Stamp Conversion format (e.g. Jun. 24, 2015. 00:11:12.775) 

 Pan and zoom while videos are paused, playing, or streaming live. 

 Create video clips directly from the Video Player to one of 12 different video formats by 

positioning the time sliders and clicking the export button (e.g. h264, mpg, mp4, ts, etc.). 

 Create video clips by using bookmarks to create beginning and end times. 

 Record live streams to new video files with support for 12 different video formats (e.g. h264, 

mpg, mp4, ts, etc.). 

 Snap video frames from both zoomed and panned states while paused or playing. Frames can 

be saved as jp2, jpg, tif, ntf, png. jp2 and tif Images are georeferenced and automatically 

added to the map. 

 PowerPoint integration for capturing the current video frame, the map with all graphics and 

features, associated MISB metadata, key MGRS coordinates, and bookmarks. 

 Slow motion playback, which allows more detailed analysis of high frame-rate videos  

 Measure distances directly on a video in metric or imperial units 

 Map features can be displayed on a video while playing, panning, and in a zoomed state. 

 Slow-motion slider allows fine grained control of slow motion play 

 Marks can be displayed on a video while playing, panning, and in a zoomed state. 

 Play videos using Key Frames only playback, which allows full metadata parsing, so no details 

are missed. Using Key Frame only playback frees up resources allowing more videos to be 

played simultaneously.  

 The Accuracy option, which includes DEM, DTED, and elevation constant integration, 

increases locational accuracy while displaying map features, editing, and marking on the video. 

Accuracy also supports increased accuracy while panning and zooming the video. 

 Video graphics are drawn more efficiently and are now updated while stepping forward and 

time sliding (marks, frame outline, platform, frame center, and field of view). 

 Follow options allow following video graphics at full extent, full extent expanded, and with a 

manual option. There are also options for Follow All Videos and Stop Following All Videos. 

 Video Player windows automatically resize. There is a manual resize option for users with 

Windows Classic or Windows High Contrast. 

 Improvements to the video marking tool, including save and remove marks options in the 

context menu. Marks also remain until explicitly cleared by the user.  

 The ‘Refresh Graphics Tool’ allows users to clear platform trails, frame outlines, and frame 

centers that are “off” due to bad data or video resets while leaving Marks in place. 

 Shortcuts have been added to context menus allowing users quicker access to key 

functionality. 

 Copy and paste values directly from the metadata viewer 

 The FMV geoprocessing  tools include a ‘Full Motion Video Tools.tbx’ file installed with the 

toolset. The toolbox can be found under ArcCatalog > Toolboxes > System Toolboxes > Full 

Motion Video Tools. 

 Right-click the clip and ship slider handles or use CTRL + E for a video export shortcut. 
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 Performance improvements and tools including: 

o Key frame only playback 

o Hardware Acceleration and Software Only modes for better performance allowing 

users to customize their FMV for their CPU/GPU configurations. 

o Linear resampling and High Resolution modes have been added allowing users to 

further customize their FMV performance environment.  

o Easy to use on/off video graphics controls allowing users to manually reduce the load 

incurred from graphics rendering. Users can turn graphics on and off from the Video 

Manager and from each individual video. 

 Video metadata recording is supported in both file and enterprise geodatabases (Oracle, SQL 

Server, DB2, Informix, Netezza, PostgreSQL). 

 FMV geoprocessing tools with support for metadata recording, mosaicking, and video extent 

extraction allow for data capture at over 25x normal play speed. 

 Metadata can now be recorded at user defined rates. 

 Video frames can be mosaicked at user defined rates. 

 The FMV add-in projects video metadata on the fly to any projected or geographic coordinate 

system. Base maps can be any coordinate system. 

 The Intersect tool supports interaction with feature classes in any geographic or projected 

coordinate system.  

 Increased support for dropped or interrupted live streams, videos no longer have to be 

removed and re-added if a live stream is lost. 

 Customizable field-of-view graphic showing the relationship between the camera and the frame 

outline on the map. 

 Increased metadata accuracy improves calculations during video digitizing, marking, and 

intersecting. 

 The Add Live Video Stream tool is supported by auto-complete functionality, which remembers 

frequently used streams. 

 Improved bookmarking with a new elapsed time field and XML import and export, which allows 

commas in the Description field. Bookmarks can be imported or exported as CSV or XML. 

 The zoom tool zooms to the extent of all open videos with a single click. 

 The follow tool lets the user set, adjust, and maintain a custom map scale while following.  

 Automatically follow more than one video at a time by simply selecting videos of interest and 

unselecting them to stop. 

 Updated the player window with improved on-open scaling. The player window now opens to 

an optimal height and width ratio for each video. 

 An improved UI with Intersecting Features and Time Query shortcuts in the Video Manager 

window. 

 An improved video editing UI with cursors and vector and line graphics that emulate an 

ArcMap edit session. 

 Feature Intersect can be enabled and disabled from an individual video’s context menu. 

 Easily sketch Map-to-Video and Video-to-Map points and save them using the new Mark Map 

and Video tools. 

 Increased accuracy and improved graphics when digitizing polygons directly on a video.  

 The accuracy of the video player clock has been greatly improved. 

 Video player controls are sized proportionally when the video player window resizes. 
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 It is easier to resize the video player with the set initial display size, fit player to video, and fit 

player to display tools. The video can be resized with a single click while preserving aspect 

ratio and max display and video resolution. 

 The Maximum Player Size calculations account for a Windows task bar. 

 The Bookmark Manager shows Elapsed Time and UNIXTimeStamp making it easier to find the 

time and place you’re looking for. 

 A video’s source, archive or live stream address, can be copied directly from the Video 

Manager dockable window to the clipboard.  

 The video player window automatically resizes to fit the user-defined window size and the 

aspect ratio of the video. There are also tools that help the user maximize the video to best fit 

its recorded resolution. 

 Full Motion Video Toolbar with Live Stream, Archive Play, and Video Manager tools  

 Built on the easy to install, uninstall, and share Microsoft Add-in technology 

 Recognizes and plays ps, ts, mpg, mpeg, mp2, mpg2, mpeg2, mp4, mpg4, mpeg4, H.264, vob, 

and mt2s videos 

 Supports the MISB video standards http://www.gwg.nga.mil/misb/ 

 Supports STANAG 4609 

 Full DVR control set 

 Full support for live video streaming (UDP and RTSP streams over IPv4) 

 Time synced playback with time-aware layers  

 Easily create and load raster mosaics by simply playing a video 

 Image snap shot recorder for. ntf, .tif, .png, and .jpg recording 

 KLV (key-length value) parsing and Metadata recording with the ability to save platform, 

footprint, and target vector information to feature classes  

 KLV/metadata viewer and recorder lets the user see and record metadata streams as videos 

play in real-time 

 Video to Map digitizing for points, lines, and polygons using feature templates and feature 

classes 

 Automatic map follow and refresh capability for platform, footprint, and frame center objects 

 Video bookmarking for taking notes and saving and returning to locations within a video 

 Ability to set symbology for individual videos using the Esri symbol set, as well as, custom 

symbols 

 Ability to play and manage multiple videos simultaneously 

 Easily manage videos in the Video Manager dockable window 

 Videos and custom properties are saved within your .mxd’s and are easily accessible for later 

use 

 ESD Metadata Support 

o The ESD metadata standard is fully supported along with MISB 0601.5 and MISB 0104.5.  

 Live Streams 

o Full support for live video streaming (UDP and RTSP streams over IPv4) 

 Smart Metadata Parsing 

o Users no longer have to explicitly define a single metadata standard. The application will 

now automatically figure out the video's standard or standards and parse them 

accordingly. 

 Feature Scan 

http://www.gwg.nga.mil/misb/
http://docplayer.net/7371542-Nato-unclassified-stanag-4609-edition-3.html
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o Point, line, and polygon map features are shown on the video, in real-time as the video 

plays.  

o Complex geometries, such as multi-points, multi-lines, and polygons with donut holes and 

islands are fully supported. 

o Show Map Geometry on Video and Clear Map Geometry from Video tools: These tools let 

the user query all point, line, and polygon features contained within the current video frame 

and show them on the video with a single click. 

 

 Display x/y on Video Tool 

o This tool lets the user click on the map and see a corresponding point show up on the 

video giving the user a quick look at relative accuracy and location. 

 Digitizing 

o Digitized features can be added with full Esri template support.  

o Geometry can be immediately seen after sketching on the video using Feature Scan 

o Finish and delete sketch items have been added to the context menus 

o Digitized geometries can be completed by right-clicking and selecting Finish Sketch from 

the context menu or by double-clicking the video 

 Bookmarking 

o Bookmarking is supported by a dedicated Bookmark Manager  

o Support for export and import via .csv file 

o Support for add, remove, delete, and search using the name, and description fields 

o Bookmarking is also supported by tick marks on the time-slider and a dedicated menu with 

individual search capabilities  

o Bookmarks can be added by using the Ctrl+B shortcut 

 Drag Drop Support 

o Drag/Drop is supported within the Video Manager dockable window for easy organization 

of videos 

o Drag/Drop is supported from ArcCatalog and Windows Explorer for adding videos to the 

Video Manager 

 Shortcut Buttons 

o Record, Mosaic, and Time-Sync all have single-click-to-start buttons on the Video 

Manager dockable window for ease of use 

 Menus 

o Menus have been simplified and reorganized to support improved workflow 

 Metadata Viewer 

o Accuracy and performance have been improved and items are now shown alphabetically 
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Installing the FMV Add-In 
 

There are two ways to install the FMV Add-In. If you are updating from a previous version of FMV, you will 
need to uninstall it first. 

 

Installing FMV for the first time: 

Steps: 

1.  In the Windows file manager, navigate to the location where you downloaded the zip file package 
containing the Add-In. 

 
2.  Unzip the package. 

 
3.  Double-click the Add-In file, named "ESRI.ArcGIS.Video.FullMotionVideoAddin.esriAddIn". 

 
4.  Click the Install Add-In button to confirm the file installation of the ArcGIS Full Motion Video 

Add-In 1.3.1. The utility copies the Add-In file to your default ArcGIS Add-In folder. 

5.  Click OK. 
 

6.  Open ArcMap. 
 

7.  Click the Customize menu in ArcMap and click Extensions. The Full Motion Video check 

box should be selected. If it isn't, close and restart ArcMap to ensure that the add-in is 

recognized. 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.  Click Close. 

The Add-In is now ready to use. 

 
Updating a previous version 

 
Removing a previous version of FMV from the Add-In Manager: 

 

Steps: 
 

1.  Open ArcMap. 
 

2.  Click Customize > Add-In Manager 
 

3.  Under My Add-ins select the previous version of Full Motion Video that needs to be removed. 
 

4.  Select Delete this Add-in. 

The previous version of FMV will be removed 
 

5.  From the Add-In Manager, click Customize. 
 

6.  On the Customize dialog box click Add From File 
 

7.  Browse to the "ESRI.ArcGIS.Video.FullMotionVideoAddIn.esriAddIn" Add-In file, click the file to 
select it, and click Open. 
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8.  Click the Install Add-In button to confirm the file installation. The utility copies the Add-In file 

to your default ArcGIS Add-In folder. A list of the added objects is displayed. 

9.  Click OK. 
 

10.  On the Toolbars tab of the Customize dialog box check the ArcGIS Full Motion Video toolbar. 
 

11.  Click Close. 

 

The ArcGIS Full Motion Video toolbar will appear. 

  

12.  Click the Customize menu in ArcMap and click Extensions. 

13.  ArcGIS Full Motion Video should now be listed and checked on. If it is not, close and restart 
ArcMap. 

 
14.  Click Close. 

 
15.  Full Motion Video will now be listed under Add-Ins in the Add-In Manager. 

 
16.  Click Close. 

The Add-In should be ready to use. 

 
Add video file types in ArcCatalog 

 
The ArcGIS Full Motion Video 1.3.1 Add-In is now ready for use. The first step is to add the recognized 
video file formats. 

 

Steps: 
 

1.  Open ArcCatalog. 
 

2.  To see what video file types are currently supported open the Customize menu and click 
ArcCatalog Options. 

 
3.  Navigate to the File Type tab. 

The File Types tab lists supported file types and allows the user to specify new file types that will 
be shown in Catalog. 

 
4.  Click the New Type button. 

 
5.  In the File Type dialog box type the file extension, as well as a description of the file type. 

Note: in this example an MPEG-2 Transport Stream, which has a '.ts' file extension, is being 
added. 

 

 

6.  Click OK. 

The file type is added and will now be visible in ArcCatalog. 
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7.  Click the Apply. 
 

8.  Add any other video file types that need to be displayed in ArcMap using steps 4 - 7. 
 

The following is a comprehensive list of the supported file types: 
 

Description   Extension 
 

H.264 Video File  H264 

MPEG File   MPG  

MPEG File   MPEG  

MPEG-2 File   MP2 

MPEG-2 File   MPG2 

MPEG-2 File   MPEG2 

MPEG-4 File   MP4 

MPEG-4 File   MPG4 

MPEG-4 File   MPEG4 

MPEG-2 Program Stream PS  

MPEG-2 Transport Stream TS  

ESD File   VOB 

 
 

9.  Click OK to close the ArcCatalog Options dialog box. 
 
Add the Full Motion Video Toolbar to ArcMap 
 

The ArcGIS Full Motion Video 1.3 Add-In provides a toolbar for working with video files in ArcMap. If it is 
not visible, add the toolbar to 

ArcMap. To do so: 

 

Steps: 
 

1.  In ArcMap, click Customize, point to Toolbars, and click ArcGIS Full Motion Video to show the 
toolbar. 
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Installing the FMV geoprocessing tools 
 

The geoprocessing tools that come with the Full Motion Video Add-In are designed to extent the 

utility of the FMV functionality. These tools extract or properly prepare metadata for use in the Add-

In, search video archives depending on feature, time and/or location, and mosaic datasets from 

your videos. The tools can be used independently, in python scripts or in geoprocessing models. To 

install the tools: 
 

Steps: 
 

1. If you are updating a previous version of the FMV geoprocessing tools, you must first explicitly 

uninstall the previous version: 

a. Control Panel > Programs > Programs and Features > Uninstall or change a program 

b. Right click on ArcGIS 10.x Full Motion Video Geoprocessing Tools and select Uninstall 

c. The program asks if you are sure you want to uninstall the program, select yes 

2. Navigate to the software subfolder where FMV was installed. Here you will see a folder 

containing the geoprocessing tools specific to the version of ArcGIS that you requested. 

3. Double click setup.exe to start the installation, and follow the steps on the wizard. 
The installation package now creates a toolbox on the user's behalf. The toolbox is located in 
ArcCatalog under Toolboxes > System Toolboxes > Full Motion Video Tools.tbx. The toolbox 
is installed to the user's install directory. 
For example, C:\program files (x86)\arcgis\desktop10.3\ArcToolbox\Toolboxes\Full Motion Video 
Tools.tbx. 

4. After installation, click on the Customize tab and select Extension to ensure the Full Motion Video 
extension is added and checked on.  

5. If the Full Motion Video extension is not visible in the list of available extensions, exit ArcMap and 
restart the ArcMap application. Click on the Customize tab and select Extension to ensure the Full 
Motion Video extension is added and checked on.  

 

 Note:   The multiplexing field mapping and time shift templates are available after the Geoprocessing 

tools are installed. Go to your install directory and look for a folder called Video Multiplexer Templates. 

A typical location is C:\Program Files (x86)\ArcGIS 10.3.1 Full Motion Video Geoprocessing 

Tools\VideoMultiplexerTemplates. The files are titled 

Video_Multiplexer_MISB_Field_Mapping_Template.csv and 

Video_Multiplexer_TimeShift_Template.csv. ” 
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Using the ArcGIS Full Motion Video 1.3.1 Add-In 
 

Overview 
The FMV Add-In is comprised of 3 main functional components, the Video Manager, Video Player and 
Geoprocessing tools designed to extend the utility of the FMV application to accommodate common real-
world operational scenarios. These functional components are integrated to work together, and result in a 
robust Full Motion Video experience. Each of these components are addressed in turn according to a 
generic workflow.  
 

Play an archived video file 
 

To play an archived video file, you need to know its location. 

 

Steps: 
 

1.  From the toolbar click the Add An Archived Video File button. 

 

2.  Navigate to the video file, highlight it, and click Add. 

The ArcGIS Full Motion Video Player opens. 

 

The lower part of the ArcGIS Full Motion Video Player has buttons to control the playback 

of the video. The following table describes what each of the buttons on the interface do. 
 

Button  Functionality 

                        Create a bookmark (Ctrl + B) 

                        Take a screenshot of the current frame 

                        Start/Stop displaying features from the map on the video 

                        Enable/Disable marking 
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                        Measure 

                        Start/Stop querying time-aware layers 

                        Clip the video 

                        Export to Power Point 
 

The ArcGIS Full Motion Video Player displays the recording status, where it is white 

for not recording, and red for recording. 

 

3.  Click the up arrow to hide the ArcGIS Full Motion Video Player buttons while viewing a video. 
Click the down arrow to show the buttons again. 

 
4.  To play the video at a rate less or more than normal playback, use the slow motion control at 

the bottom of the video player. The slow motion control allows fine-grained control over 
playback speed. The range of values extends from 0.00x to 3x play speed. The tick in the 
middle of the control is 1x speed, or normal playback speed. 
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Some key points about slow motion control: 

•   Values below 1x can be changed in increments of 0.01 by using the left and right arrows on 
the keyboard. 

 
•   0.00x is the equivalent of pause. 

 
•   Double click the slow motion slider to automatically return to a playback speed of 1x. 

 
•   The slow motion playback rate is reset to 1x whenever any of the time slider or 

standard DVR controls are used. 

•   The slow motion control can be used with live streams by clicking the Review the 

previous 30 seconds of live stream button. If you are watching a live stream, but 

not reviewing the previous thirty seconds then the slow motion control will have no 

impact. 

 
Play a live video stream 

 
To play a live video stream, you will need either the UDP, RTSP, or MJPG address of the video stream. 

 
 Note:   The Full Motion Video player currently supports Internet Protocol version 4 

(IPv4) addresses and both the User Datagram Protocol (UDP) and the Real 
Time Streaming Protocol (RTSP). MPEG TS streams can be broadcast as UDP 
unicast or multicast and can include MPEG-1, MPEG-2, and H.264 video 
decoding, and KLV metadata parsing. RTSP playback is supported for live 
RTSP streams that use any of the following video codecs: MPEG-1 Video, 
MPEG-2 Video, H.264, and MJPEG. 
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The interface when streaming a video is different that when playing an archived video. 
 

 
 
The following table describes the functionality of each button when streaming a video. 

 
Button                         Functionality 

                  Take a screenshot of the current frame 

                  Start/Stop displaying features from the map on the video 

                  Enable/Disable marking 

                  Measure 

                  Start/Stop querying time-aware layers 

                  Start/Stop recording 

                  Resume stream 

                  Export the previous 30 seconds of the stream 

                  Export frame to Power Point 
 
 
Steps: 

 
1. Click the Add A Video Stream button.  

 
 

2. The Add Video Stream dialog box opens. 
 

 



Using the ArcGIS Full Motion Video 1.3.1 Add-In 

18 Copyright © 1995-2016 Esri. All rights reserved. 

 

 

 

3.  Type the address of the video stream in the dialog box. 
 

4.  Click Open. 

 

 

 
Automatically Follow Videos 

 
The follow tool allows the map extent to automatically refresh around the metadata of one or more 

videos. Follow can be set on a video- by-video basis or for all videos at once. 

To set Follow on an individual video right-click on the video player and select Follow. 
 



Using the ArcGIS Full Motion Video 1.3.1 Add-In 

19 Copyright © 1995-2016 Esri. All rights reserved. 

 

 

To set Follow for all videos, from the Video Manager View > Follow > Follow Videos. To stop following all 
videos, from the Video 

Manager View > Follow > Stop Following Videos. 
 

Follow can be customized from the Video Manager View > Follow. There are three choices: 

•   Full Extent - automatically zooms the map into the metadata for each enabled video at a ratio of 1.2 
 

•   Full Extent Expanded - automatically zooms the map into the metadata for each enabled video at a 
ratio of 2.2 

 
•   Manually Set Extent - allows the user to customize the envelope around the video metadata 

by using ArcMap's built in zoom controls and settings 
 

 Note:   This can be a computationally intensive process if you have a large amount 

of data on your map or slower service-based layers. 

 

Manually Resize Video Players 

By default, when a video player window is resized, the player window snaps to the video's default aspect 
ratio. This capability is on by default and can be turned off and on by going to the Video Manager. 
 

Recording Metadata 

The Metadata dialog box allows you to view and record the video's metadata stream and export it as a 
.csv file. Open the Metadata dialog box by right-clicking on the video in the video player and selecting 
Metadata. 

 
You can specify where to save the recorded metadata as a CSV file. Click the red Record button to start 
recording metadata while your video is playing. The video metadata is shown in the Metadata dialog box as 
the video plays. 
 

Record and save the previous 30 seconds of a live stream 
As a live stream plays it is buffered and the last 30 seconds are constantly saved to memory. Click the 
Review previous 30 seconds button to playback and review the buffer at your own pace. Once in 
playback mode you can review the video, take image snaps, save metadata, mosaic, and watch in slow 
motion. You can also save the clip to a new file by clicking the Export the previous 30 seconds to a 
video clip button. The naming convention is the current date and time the recording is started in UNIX time. 
For example, November 11, 2014 at 
2:34:23 pm is expressed as 20141110T143423.mpg. 
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Clipping an archived video 
 

Steps: 
 

1.  Grab the handle that is at the beginning of the time slider and move it to the point in the 

video when you want to begin the export. 

2.  Grab the handle at the end of the time slider and position it where you want to end the clip. 
 

3.  Click the Export Clip button on the Full Motion Video Player. 

Additionally, you can right-click on one of the handles or use the Ctrl + E shortcut to export. 
 

The portion of the video between the two handles will be saved. The naming convention is the 
name of the original video_start clip time_end clip time. For example, if a video called 
MyVideo.mpg is 10 minutes long and the clip starts at three minutes forty seven seconds 
(00:03:47) and ends at 00:07:42 then the name of the clip will be MyVideo_00-03-47_00-07-
42.mpg. 

 
 Note:   To return the handles to their original position, double click on one of the 

handles. Alternatively, you can drag both handles to the beginning and end 

of the original video. 

 

Video Search tool 
The video search tool is designed to search through a video collection and quickly identify the 
segments of videos that have recorded an area, time, or feature of interest. For instance, you 
may have identified a feature of interest and want to see which segments of all videos have 
recordings of that feature, or a subset of attribute fields. You can select the fields you are 
interested in and then use this tool to create video clips of the segments when those fields are in 
view. You can also create segments based on time, and a geographic coordinate. 

 

Steps: Open the Search Video tool from the Full Motion Video toolbar, or from the 

Video Manager.This opens the Video Search dialog. 

First, you need to limit the scope of your search. 

 

Use the options in the first section to define your search terms. To limit the extent of the 
search, you can constrain it to only videos that have recorded what is currently displayed 
in the map. Alternatively, you can draw a bounding box to limit the search area. 
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.  
1. If you want to identify video segments that have recorded a feature of interest, make the selection 

from the map, and then check on Search by selected features. 

2. To find videos that have recorded during a specific time range, use the Search by time range 
option and input the correct starting and ending time and date. You can use any or all of these 
options to limit the search. 

 
Second, you need to tell the tool which videos to search. 
 
Steps: 

 
1. Use the second section of the Video Search tool to search either one video or multiple videos. 

Remember that this tool is not just identifying which videos meet the search criteria; it will create 
clips of the video segments based on that criteria.  
 

2. Start with saving a toolbox and geoprocessing model to index multiple videos. This will prompt 
you to save the toolbox to a location. Once you have done so, use the ArcCatalog pane to 
navigate to that toolbox. Right-click on extract metadata from multiple videos and Edit the model. 
This will open up the Model Builder view. 
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3. Populate the fields for the location of videos. You can navigate to the folder or drag and drop from 

the ArcCatalog Pane. 
 

4. The output workspace must be a file geodatabase or an enterprise geodatabase. Save and close 
the model. 

 
By creating this model, you have set up a workflow where you can easily manage the regular 
arrival of new videos. To use this model, you either save new videos into this folder, or you can 
update the folder that the model looks for.  

 
5. To create new indexes, select Open Existing Geoprocessing Model or use the geoprocessing tool 

(if you are working with a singular video) and browse to the model that you want to edit. Note that 
indexes are created quickly. It’s encouraged to create them as often as you see fit. 
 

6. From ArcCatalog, navigate to the geodatabase where the indexes were written to. At the top of 
the ArcCatalog pane there is an icon for a tree structure, click on this and at the bottom of the 
pane you will see all of the feature classes that were indexed.  

 
 
 

 
 
7. Create a new feature dataset, following all of the defaults, and add all of the existing feature 

classes into that feature dataset. Once complete, use the plus button at the bottom of the Video 
Search tool to add the feature dataset.  
 

8. Click Search.  
 
Finally, you want to view the results of your search. 
 

Steps: 
 

1. When the search is complete, open the Results window.  
 
 

2. If you have multiple segments, it is encouraged to sort the segments by their length. Usually, the 
videos that spend the most time over the feature or area of interest have the best video.  
 

3. To view a particular segment, right click on it, and select Queue Video. If you used a selection as 
part of your search, check on the Display features from the map on the video box. The videos 
will play with the selected feature highlighted.  
 

4. You can save the results of your search as an .xml file. This is useful when working with 
colleagues and all videos are stored in a shared location.  
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Marking and digitizing features 
 

The Mark Map and Video button lets you click a point on the map within the video footprint, and see 
where that point is on the video. It also lets you click a point on the video and see where that point is 
on the map. The point that is created is temporary. To save points, right click on the video and select 
Save Marks. Marks are useful for determining relative accuracy. When enabled, you can mark points 
directly from the video window or from the map document. 

 
 Steps:

 
 
 
To mark point features directly from the map or video:

 
1. Click the Mark Map and Video button to start using the tool.  

 

 

 

2. Click once on the map and a corresponding point will appear on the video. You can click 

on the map again to see additional points on the video. If you have several videos, the tool 

will detect each video's footprint and add points to each video for which the point falls 

within the video footprint. 

a. Once you've completed using the tool, you can save the points as a feature class. 

3. Right-click on the video and click Save Marks. 

4. To clear the graphics from a selected video, right-click the video and click Remove Marks 

and Graphics. 

5. To clear the graphics from all of the videos, select Remove Marks and Graphics from the 

Edit menu in the Full Motion Video Manager 

 

Digitizing features is a more robust workflow that integrates seamlessly with the ArcGIS editing tools 

and feature templates. Whereas marking allows you to create points, digitizing allows you to create 
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points, lines, and polygons. When you digitize features you can add values to the attribute table of the 

features. 

 

Features digitized in the video are displayed on the map, and features displayed and digitized in 
the map are displayed on the video in a seamless bi-directional manner. 
 

To digitize point, line, polyline or polygon features, you will need to open an editing session. Learn more 
about editing features. 

 
Make measurements from video 

 
Measure distances as well as the perimeters of features with this tool directly from the video. At 
this time, measuring areas is not supported. To make a measurement from the video: 

 

Steps: 
 

1.  Start playing the video and pause it when the feature perimeter or distance you want to measure 
is on the screen. 

Accuracy will be improved if the sensor is looking directly down at the feature and if you 

have incorporated an elevation dataset. 

2.  Click the measure button. 
 

3.  Click once at the point where you want to begin the measurement from. Click again at the 
second point. 

 

file:///c:/temp/Using_FMV_2014-11-15_16_01_22.647000/output/GUID-0B236129-9DDD-41F6-B9D4-F7EA4C93C302
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4.   To measure a perimeter, click on the corners of the feature until you get to the original 

point. Double click to finalize the measurement. 

 
Export to PowerPoint 

 
Video content, such as the current frame, current video player extent (zoom/pan), full extent of the frame 
outline, and full extent of the frame center, frame outline, and platform, can be exported to PowerPoint.  

 
New PowerPoint slides are first created in any open and active PowerPoint presentation by default. If there are 
no open presentations, a new presentation is created using the default directory and filename. This allows you 
to push data to any active presentation by first clicking on the PowerPoint to make it active and then clicking on 
the Create PowerPoint slide from the current video frame button. By default, a slide is created showing the 
current frame without pan and zoom. To add additional slides to the PowerPoint, go to Video Manager > 
Customize > PowerPoint Presentations and include the Current video player extent, Full extent of the 
frame outline, or Full extent of the frame center, frame outline, and platform. 
 

Metadata pertaining to the video clip is also exported to the PowerPoint presentation. This includes the source 
video name and file location, UNIX time stamp, Platform latitude and longitude, Frame Center, and Frame 
Corner location in latitude/longitude.  
 

Manage Videos 
 

The ArcGIS Full Motion Video Manager window lets you set properties and control the videos in your 
map. 

 

Steps: 
 

1.  Click the ArcGIS Full Motion Video Manager button. 
 

 

The ArcGIS Full Motion Video Manager opens. 
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Using the ArcGIS Full Motion Video Manager Menus 

 
You can drag and drop videos from ArcCatalog and Windows Explorer onto the Full Motion Video Manager. 
The File menu allows you to stream, add, and remove videos from the video manager. 
 
The Edit menu lets you remove all marks from the map and each video. 
 
The View menu lets you zoom to the extent of all videos, follow what the video is recording on the map, 
control graphics, enable key frames, and set the refresh rate. 
 
The Bookmarks menu provides quick access to any frames in any of the videos that you have 
bookmarked. 

 
The Search menu allows you to search for videos based on location, time, and intersection with selected 
features. You can also import search criteria.  
 
The Customize menu lets you add an elevation model to enhance positional accuracy. Additionally, you 
can resize the video player, set the properties for exporting to Power Point, and you can reset the time 
extent for ArcMap to its default. From this menu, you can set the units of measurement to metric or imperial. 
 

 Note:   The options on the Edit, View, and Customize menus apply to all videos. 
 

 Note:   Set the following options to increase performance. 
 
•   Stop following videos. View > Follow > Stop Following Videos  
 
Hide graphics. View > Graphics > Hide Graphics. This hides video frame footprints, ground track and 
other graphical information associated with the video. 
 
Try both Software rendering and Hardware acceleration to see which works best for your system. View > 
Graphics > Software rendering/Hardware acceleration 
 
•   Use linear resampling. View > Graphics > Linear resampling 
 
•   Use key frames only View > Key frames > Enable key frames 

 
Accessing the Property Pages 
To view and configure the properties associated with an individual video, use the property pages. The 
capabilities of each page are described in the following section. 

 
Steps: 

 
1.  From the manager, right click on a video and select Properties from the context menu to launch the 

Properties dialog box. 
The Properties dialog box opens. 
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Accuracy Tab 

Use the Accuracy tab to enhance to positional accuracy of features and graphics on both the video and 
map using an elevation model. The increased accuracy applies to video digitizing, video marking, and 
displaying features from the map on the video. The dataset must be a single band elevation dataset, such 
as the Esri elevation image service. 

 

 
Bookmarks Tab 
The Bookmarks tab shows all of the bookmarks that you have created for this video and allows you to 
manage them. The menu is empty until you add a bookmark to capture a specific time within the video. 
Check the Display description in the bookmark menu box to show or hide long descriptions in the 
bookmark menu. Use the Import bookmarks button to import bookmarks from a .csv file or from an .xml 
file. To clip part of a video using bookmarks, select the bookmarks that represent the beginning and end 
points and click the 

 

Select two bookmarks to export a video clip button. 

 

 
 
 

 Note:   You can add a bookmark from the bookmark button in the video player 

window, from the button in the Bookmarks properties dialog box, and by using 
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the Ctrl + B shortcut when the video properties window is in focus. Bookmarks 

are indicated by tick marks on the time-slider of the video player. 

 

 
The following table describes the functionality of the buttons on the Bookmarks property page. 

 
Button    Functionality 

    Create new bookmark 

    Delete bookmark 

     Export bookmarks  

    Import bookmarks  

    Clip using bookmarks 

  Search 

 

General Tab 
 

The General tab gives you options for adjusting the duration of each step forward and backward increment. 
The effect of these values is dependent upon each individual video’s metadata density; therefore actual 
step increments may not directly reflect the values set in the increment controls.   
 
When displaying map features and marks, check the box “Check to maintain smooth playback for videos 
with minimal metadata”. 
 

 
 
 
 

Imagery Tab 
 
The Imagery tab is where you set the properties of video frame images saved to disk. There are two sub 
tabs for setting properties of the 2 modes of capturing imagery; either as single frames or as groups of 
images. Each mode has specific property setting options for capturing video frames.  
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Capture Single Images 
The Capture Single Images is invoked when the camera icon button is pressed on the video player. The 
camera button captures single digital video frames to disk, either when the video is in the pause state, or 
during video playing an archived video or a live stream video. Several popular image formats are included, 
and georeferencing information is included for formats that inherently handle it. For example .tif and .JP2 
support georeferencing data while .png and .jpg do not.  

 
 
Images may be saved in any of the supported image formats including: 

 
Supported Image 

file formats 
Notes 

.tif 
 TIFF files without metadata will be saved as PNG and are not added to 

the map 

.jp2 
 JP2 files without metadata will be saved as PNG and are not added to 

the map 

.jpg  JPG files are not georeferenced or added to the map. 

.ntf 
 NTF files are georeferenced, but not map projected 

 NTF file format is not supported while panning and zooming in the video 
player. The video player must be in Pause mode to capture NTF files. 

.png  PNG files are not georeferenced or added to the map. 

 
Output Directory: 
Specify the directory for the captured images to be saved to disk. The default directory is 
D:\Documents\ArcGIS 
 
Captured georeferenced imagery may be added to the map as they are saved to disk by checking the 
checkbox. 
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Capture Groups of Images 
Capturing groups of images is the workflow where multiple video frames are captured at a specified interval 
as the video player is playing an archived or live streaming video. These groups of images usually have 
good overlap and are conducive to generating mosaic datasets via integrated geoprocessing tools. Since 
these collections of images are georeferenced and can be saved in standard formats they can also be 
easily imported into other image processing environments such as orthorectification and exploitation 
applications. 

 
To start capturing digital video frames to disk, go to the Video Manger and click the Capture button 
associated with the video. The video may be a live streaming of archived video. Video frames are only 
captured while the video is playing. Capture stops when the video player is in pause or stop modes, or the 
capture button on the Video Manager is deselected with a click.  

  
When video frame capture is turned on in the Video Manager, the Recording Status in the Video Player is 
turned to red (i.e., active, see below). 



Using the ArcGIS Full Motion Video 1.3.1 Add-In 

31 Copyright © 1995-2016 Esri. All rights reserved. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The group of video frames are captured in the NTF format and saved to the specified directory. The first 
step is to set the video frame capture rate. This value determines how often NTF files are captured while 
a video plays. For example, if your video is recorded at 30 frames per second and you specify a capture 
rate of .500 milliseconds, 2 video frames per second will be captured to disk. High capture rates resulting 
in large numbers of digital video frames saved to disk may decrease performance of the video player 
playback.  
 
The output directory of the collection of video frames is specified via the output file browser. If no directory 
is specified, the default capture directory is D:\Documents\ArcGIS\Input_Video_File_Name 
 
After video frames are captured, you can add them to a mosaic dataset straightforwardly by using the Full 
Motion Video Tools > Mosaic Video Frames geoprocessing Tool. The mosaic dataset workflow is 
addressed in the section following this Property Page section. 
 
Metadata Tab 
The Metadata tab controls where you save the platform, frame center and frame outline when recording 
metadata. You can either use the default feature classes, select an existing feature class or create a new 
one. When recording you have the option to add the layers to the map as they are captured.  

 



Using the ArcGIS Full Motion Video 1.3.1 Add-In 

32 Copyright © 1995-2016 Esri. All rights reserved. 

 

 

 
 
Symbology Tab 
The Symbology tab allows you to change the symbol color and style for the field of view, platform, frame 
center, and frame outline. You can add a trail following the platform, and you can set its length. You can 
check boxes here to make the map automatically pan to follow the platform, the center of the video frame, 
or the outline of the video frame. The follow capability is also available by right-clicking on the video in the 
video player and clicking Follow 
 

 

Time Tab 

 
The Time tab lets you determine how often to query time-aware layers. Use the Query Forward and 
Query Backward options to create a time window before and after each frame. This is useful if you want 
to see if features occupy the current video frame at a given time. 

 Note:   For each time-aware layer that will be queried, it is important to enable time. 
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         Steps: 
 

1.  From the ArcMap table of contents, right-click on a time-aware layer to open the Properties 
dialog. 

 
2.  Click the Time tab. 

 
3.  Check Enable time on this layer 

 
4.  Click the Calculate button to create a valid time step interval. 

 

In the video manager, the Time Query button allows you to query time-aware layers. 
 

 Note:   Time querying may require significant resources depending on the number 
of time-aware layers and features. After running a single time query, ArcMap 
will be left in a queried state. At this point it may be necessary to use the 
Reset Time Extent button on the Customize menu of the Video Manager to 
view the full time extent of all of the layers in ArcMap. 

 

Workflow to create a mosaic dataset from video frames 
The video frame image mosaicking workflow in this FMV 1.3.1 Add-In release is different than previous 
FMV Add-In releases. This new workflow accommodates the newly supported file formats such as .tif and 
jp2, and thus supports more flexible and robust workflows and easy integration with different applications. 
 
Two different workflows are supported for processing video frames into a mosaic dataset. The first workflow 
is interactive while the second method is a “batch mode” workflow. The interactive workflow is addressed 
first. 
 
Interactive Mosaic Dataset 
Interactively mosaicking digital video frames is a two-step process. The first step is to capture groups of 
video frames in .ntf format to an output directory described above in the Imagery Tab of the Property Page 
section. When viewing a video, a user decides to generate a mosaic dataset of a segment of the video as it 
plays in the Video Player. The video frames are stored in an output directory staged for creating the mosaic 
in the second step. The next step is to create the image mosaic dataset using the Mosaic Video Frames 
geoprocessing Tool.  
 
In the second step, the Mosaic Video Frames geoprocessing tool is used to mosaic the captured video 
images staged in the output directory in .ntf format. Video Frames geoprocessing Tool is designed to easily 
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mosaic the captured video frames into a mosaic dataset. When completed, the tool will automatically build 
footprints, boundaries, and overviews for the mosaic dataset. 
 
The geoprocessing tool for creating the mosaic dataset is simple and robust. There are four required input 
to the Mosaic Video Frames tool as follows: 

 
Input Video frames and Metadata Directory -   this is typically the directory specified when capturing 
video frames, specified in the video’s Property Pages, Imagery Tab > Mosaic Groups of Images. Of course 
it can be changed as long as the directory contains all the video frames and associated metadata.  
 
Output Location – the name and location for saving the created Mosaic Dataset. This must be a 
Geodatabase (.gdb). 
 
Output image Directory – The video frames are originally stored in native .ntf format. Video frames stored 
as .ntf are georeferenced, but not warped to a map projection. In order to create a mosaic using video 
frame images in a map projection, they must be converted to .tif or .jp2 format using the georeferencing 
metadata contained in the .ntf files. This conversion is done automatically; thus simply specify the output 
directory where the map projected .tif or jp2 files are to be stored. 
 

Output Image Type – specify your choice of two types of image formats; .tif or jp2.  
Click on the OK button to create the mosaic dataset and write it to disk. The Mosaic Video Frames 
geoprocessing tool automatically creates the mosaic and associated statistics, and builds footprints, 
boundaries, and overviews for the mosaic dataset. Load the mosaic dataset into ArcMap. 

 

 
 
The graphic above illustrates the mosaic dataset created from the captured video frames and loaded into 
the ArcMap display. In the Table of Contents shows the mosaic dataset including the .gdb, the boundary, 
footprints and imagery contained in the mosaic dataset. The attribute table of the mosaic dataset is 
displayed along with the property page of an individual video frame image in the mosaic; item 2 of the 
mosaic dataset in this example. Please refer to the Desktop help. 

 

http://desktop.arcgis.com/en/arcmap/latest/manage-data/raster-and-images/what-is-a-mosaic-dataset.htm
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The mosaic dataset is created according to the tool’s parameter settings as follows. 

 
Input Video File – The video must be one of the supported video file types; i.e., .ps, .ts, .mpg, .mpeg, 

.mp2, .mpg2, .mpeg2, .mp4, .mpg4, .mpeg4, .h264, .vob, or .mt2s. 
 
Output Location - The geodatabase where the mosaic dataset will be saved. 
 
Output Image Directory - The directory where the map projected image files used in the mosaic dataset 
will be saved. 
 
Output Image Type – choose .tif or jp2 image format. The images in the specified format will be written to 
the Output Image Directory described above. 
 
Start Time - This optional value sets the recording start time from the beginning of the video. The input 
format is d.hh:mm:ss and the default start time is 0.00:00:00. This parameter allows you to specify the 
desired segment of video data from the whole video file. 
 
End Time – This optional value sets the recording end time. The input format is d.hh:mm:ss. If left unset, 
the value will default to the end of the video. This parameter allows you to specify the desired segment of 
video data taken from the whole video file 
 
Image Capture Interval – This optional parameter sets the rate of image capture from the video. A value of 
1 means that an image will be captured once every second. If left unset, the value will default to an interval 
of one video frame captured every two seconds. The minimum capture interval is 0.1 seconds 
 
Click OK to create the mosaic dataset containing the specified video frames. Load the mosaic dataset 
specified in the “Output Location” above. 
 
After the mosaic dataset is created, it is highly recommended that the user generates statistics of the 
mosaic dataset, then builds footprints of the video frame images and generates overviews, in that order. For 
more information about the mosaic dataset workflow, please refer to the Desktop help. 

 

http://desktop.arcgis.com/en/arcmap/latest/manage-data/raster-and-images/what-is-a-mosaic-dataset.htm
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Using the FMV Geoprocessing Tools 
 
There are five tools that come with the Full Motion Video add-in: Extract Video Extent, Extract Metadata 
from Video, Mosaic Video, Mosaic Video Frames and Video Multiplexer. These tools enable you to 
manage and prepare your video data for use in the video player and manager. The “Mosaic Video” and 
Mosaic Video Frame” geoprocessing tools were previously described in the Mosaic Workflow section of 
this document.  The remaining three tools are summarized below. The video multiplexer geoprocessing 
tool is described in more detail because it enables you to format your video data into MISB-compliant 
data that can be fully exploited in the FMV Add-In.  
 
 

Extract Video Extent Geoprocessing Tool 
 
Use this tool to extract the spatial extent and related attributes from a video which can be displayed on a 
map. 

 

 
Input Video File (e.g. video.ts)  
The video must be one of the supported file types: .ps, .ts, .mpg, .mpeg, .mp2, .mpg2, .mpeg2, .mp4, 
.mpg4, .mpeg4, .h264, .vob, or .mt2s. 
 
Input Feature Class  
Select an existing polygon feature class to record the spatial extent from the video. This feature class 
must have a WGS84 Geographic map projection. 
 
Start Time (d.hh:mm:ss) (optional)  
This value sets the recording start time from the beginning of the video. The input format is d.hh:mm:ss 
and the default start time is 0.00:00:00. Metadata time stamps are not used in this field. 
 
End Time (d.hh:mm:ss) (optional)  
This value sets the recording end time. The input format is d.hh:mm:ss. If left unset, the value will default 
to the end of the video. Metadata time stamps are not used in this field. 
 
Video Playback Rate (optional)  
This value represents the playback rate of the video during extraction. A value of 1 is normal playback 
speed, 2 is equal to 2x normal speed, and 10 is equal to 10x normal speed. Faster playback rates result 

in shorter extraction times and less recorded metadata. The default is to play at normal speed. 
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Metadata Extraction Rate (optional)  
This value represents the metadata extraction rate. Enter a value of 1 to record all available metadata 
packets, 2 to record every second packet, and N to record every Nth packet. The default is to record all 
metadata packets. 

 
Extract Metadata from Video Geoprocessing tool 
Data management quickly becomes an issue with users who collect video data on a regular basis.  This 
tool allows you to quickly extract video metadata and create feature classes that represent the platform, 
frame center, and frame outline.  This tool is particularly useful because it can be run at high speeds.  For 
example, one of the input variables is called Video Playback Rate.  This variable allows you to fast 
forward your video at high speeds, such as 50 or 75 times the normal play rate, thus making it easy to 
quickly archive large amounts of metadata.  Experiment with the Video Playback Rate and other 
variables.  Extremely fast playback rates may result in less metadata per video time.  Most users have 
success with a 50x playback rate with videos of 30 frames per second with metadata collection speeds at 
2-3x per second. 
 
Once the metadata is archived you use it with the FMV Search Tool as the required indexes.  The video 
FrameOutline feature class is used in the video search tool to determine intersection with the extent of the 
ArcMap display or location of features.  Or you can use it to do post-flight analysis using ArcGIS.   

 

Input Video File (e.g. video.ts)  
The video must be one of the supported file types: .ps, .ts, .mpg, .mpeg, .mp2, .mpg2, .mpeg2, .mp4, 
.mpg4, .mpeg4, .h264, .vob, or .mt2s. 
 
Output Workspace  
The workspace where the output feature classes will be saved. This location must be an SDE or File 
Geodatabase. 
 
Start Time (d.hh:mm:ss) (optional)  
This value sets the recording start time from the beginning of the video. The input format is d.hh:mm:ss 
and the default start time is 0.00:00:00. Metadata time stamps are not used in this field. 
 
End Time (d.hh:mm:ss) (optional)  
This value sets the recording end time. The input format is d.hh:mm:ss. If left unset, the value will default 
to the end of the video. Metadata time stamps are not used in this field. 
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Video Playback Rate (optional)  
This value represents the playback rate of the video during metadata extraction. A value of 1 is normal 
playback speed, 2 is equal to 2x normal speed, and 10 is equal to 10x normal speed. Faster playback 
rates result in shorter metadata extraction times and less recorded metadata. The default is to play at 
normal speed. 
 
Metadata Extraction Rate (optional)  
This value represents the metadata extraction rate. Enter a value of 1 to record all available metadata 
packets, 2 to record every second packet, and N to record every Nth packet. The default is to record all 
metadata packets.  
 

Extracting Metadata in Batch Mode 
Extracting metadata can be a time consuming activity and challenging to organize, especially if you 
collect video data on a regular basis.  This activity can be done iteratively in batch mode using a GP 
model, and the extracted metadata can be used immediately in your video searching.  
 
Every time you collect a set of new videos simply put them into the Iterators folder and run the tool.  An 
example of the model is shown below. 
 
Add a new model > Edit > Insert > Iterators > Files 
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Video Multiplexer 
 
The Video Multiplexer takes metadata, in a CSV format, and combines it with video data into any one of 
twelve supported video file types. The resulting video file is then fully MISB compliant and ready for Esri 
FMV. 

 
One of the major components of FMV data is calculation and/or display of the four corners of the video 
image frame, also called the frame outline, as shown on the map in the image above. Once you have four 
corner data you can perform many useful activities such as digitize a video, mark a video, measure distance 
on a video, create and georeference images, and more. Often videos from drones, pole mounted cameras, 
or other sources do not have four corner data. The FMV Video Multiplexer can create the four corner data 
assuming the metadata contains the proper information from an Inertial Measurement Unit (IMU) which 
records the orientation of the platform and sensor, and GPS which records the position of the platform and 
sensor. The minimum metadata requirements, and formatting into a CSV file ready for ingest into the Video 
Multiplexer tool are discussed in this section.  
 
The multiplexing field mapping and time shift templates are available after the geoprocessing tools are 
installed. Go to your install directory and look for a folder called Video Multiplexer Templates. A typical 
location is C:\Program Files (x86)\ArcGIS 10.3.1 Full Motion Video Geoprocessing 

Tools\VideoMultiplexerTemplates.”  
 
The Need for the FMV Multiplexer tool 
Multiplexing is a technical term that in the context of Full Motion Video is a process that combines your flight 
data, sensor metadata, and video stream into a single MISB-compliant video. Only videos that meet the 
MISB standard can be used within the Esri FMV Add-in. High-end sophisticated camera sensors are able to 
collect and combine the GPS, timestamps, metadata and video in real time as it is collected. However, the 
vast majority of cameras available today do not collect or multiplex all of the flight, time and sensor 
metadata that you need to include with the video stream. In order to work with this latter kind of video, you 
will need to interpolate the flight, time and sensor metadata and then combine it with the video stream into a 
single MISB-compliant video file. To do this this, you will be working with the Video Multiplexer 
geoprocessing tool. 

 
How do I know if my video needs to be multiplexed? 
The easiest way is to start playing the video and either zoom into it or start following the video track on a 
map in the ArcMap display. If the video is not in the right location (often it will be where the prime meridian 
and equator meet) it either does not include the proper metadata, or the metadata needs to be corrected via 
the multiplexer. 
 
Another common scenario is that the timing in your video is off by a few seconds. There may have been an 
issue with the clock on the camera and the GPS not being synchronized that caused a delay. This may be 
constant if the aircraft is moving at a constant speed, or the time shift may increase and decrease if the 
velocity of the aircraft is not consistent.  

 



Using the ArcGIS Full Motion Video 1.3.1 Add-In 

40 Copyright © 1995-2016 Esri. All rights reserved. 

 

 

Description of the Multiplexer Tool 

 
Input Video File (e.g. in_video.ts)  
The video must be one of the supported file types: .ps, .ts, .mpg, .mpeg, .mp2, .mpg2, .mpeg2, .mp4, 
.mpg4, .mpeg4, .h264, .vob, or .mt2s. 
 
Input Metadata File (e.g. in_video_metadata.csv)  
This is a CSV file containing metadata about video frames for individual times. Each column represents one 
metadata field, and one of the columns must be a time reference. The time reference is Unix Time Stamp 
(seconds past 1970) multiplied by one million (i.e., microseconds), stored as an integer with no decimal 
places. This is done so any instant in time (down to one millionth of a second) can be referenced with an 
integer. Consequently a time difference between two entries of 500,000 represents one half of a second in 
elapsed time. The first row contains the field names for the metadata columns. These field names can be 
matched to their corresponding MISB field names using a MISB Field Mapping CSV file, if needed. Each 
subsequent row contains the metadata values for the time indicated in the time field. A template file called 
Video_Multiplexer_MISB_Field_Mapping_Template.csv is included with installation software and is 
discussed below in the Metadata Field Mapping File section. See example of a CSV metadata file 
containing the minimum metadata parameters needed to calculate the 4 corners and thus the outline of the 
video frame footprint and display it on the map. 

 

 
 
Output Video File (e.g. out_video.ts)  
Must be specified with a file suffix, which must match one of the supported types: .ps, .ts, .mpg, .mpeg, 
.mp2, .mpg2, .mpeg2, .mp4, .mpg4, .mpeg4, .h264, .vob, or .mt2s. The new video file will be the same 
duration as the original video, but the size will likely be different depending on the bit rate settings (see 
below). 
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Metadata Field Mapping File (e.g. MISB_field_mapping.csv) (optional)  
This is a CSV (comma separated values) file containing 5 
columns and 95 rows, based on a template file included 
with the original software 
(Video_Multiplexer_MISB_Field_Mapping_Template.csv). 
Each row represents one of the standard MISB metadata 
tags (e.g., sensor latitude). The first two columns contain 
the MISB index and MISB tag name and the third column 
contains the field name as it appears in the Metadata CSV 
file (if present). The fourth and fifth columns represent the 
units and any notes associated with the tag. When the third 
column is populated the program can match the CSV 
metadata field names to the proper MISB metadata tags.  
See an example of the field mapping file. 
 
Time Shift Observations File (e.g. time_shifts.csv) 
(optional)  
Ideally the video images and the metadata are well 
synchronized in time. When this is the case the image 
footprint in FMV surrounds features that can be seen in the 
video image. However, sometimes there is a mismatch 
between the timing of the video and the timing in the 
metadata. This leads to an apparent time delay between 
when a ground feature is surrounded by the image footprint 
and when that ground feature is visible in the video image. If this time shift is observable and consistent the 
multiplexer can adjust the timing of the metadata to match the video. The time shift observations file is a 
CSV (comma separated values) file containing two columns (elapsed time and time shift) and one or two 
data rows. A row for column names is optional. 
 
Calculate Corner Coordinates  
Use the Calculate corner coordinates using sensor information (optional) checkbox to compute the corner 
coordinates, and thus the video frame outline. 
 
Average elevation (optional)  
If calculating the frame corner coordinates, an average ground elevation or average ocean depth is 
required. The accuracy of the frame coordinates depends on the accuracy of the average elevation. In order 
to calculate frame corner coordinates, the average elevation value must be less than the elevation value in 
the metadata. For example, if the video was filmed at an elevation of 10 meters and higher the valid 
average elevation could be 9 meters or less. If a video was filmed underwater at a depth of -10 meters and 
deeper the valid average elevation (relative to sea level) could be -11 or deeper. If the Sensor Altitude value 
is less than the average elevation value, the four corner coordinates will not be calculated for that record.  
The data range of the Average Elevation is a number between -900m and 19,000m.  
 

Set Bit Rate 
 
Bit rate options  
Bit rate is the number of bits that are conveyed or processed per unit of time. A video's bit rate is related to 
its quality and file size. In general, a lower bit rate will result in a higher rate of compression, require more 
time to multiplex, and output a smaller file with potentially lower quality. A higher bit rate will typically result 
in less compression, less processing time, and bigger files with potentially higher quality. When deciding 
whether to multiplex a video at a lower or higher bit rate, one may consider whether they want to stream 
and share their videos (lower bit rate) or archive their videos at maximum quality (higher bit rate). 
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There are four different ways to enter bit rate for multiplexing: 
1. Custom bit rate - Manually input a bit rate value into the “Use a custom bit rate field”.  
2. Use input video bit rate - Use the same bit rate as the Input Video File.  
3. Use video dimensions - Use the Input Video File's height and width to estimate the new bit rate. Values 

calculated this way will tend towards lower bit rates relative to the original video. This method may be 
more appropriate for streaming or sharing a video after multiplexing.  

4. Low, medium, and high action level - These values help to automatically calculate an optimized bit rate 
based on the Kush Gauge equation. The Kush Gauge equation can be helpful if you plan to stream or 
share your video after multiplexing and you don't know your user's exact bandwidth. Low, medium, and 
high action levels refer to how much things “move” within a video and help to calculate an optimized bit 
rate. For example, a video of a car race would have a high action level, a person walking may have a 
medium level, and a static façade of a building might be low. 

 
Use a custom bit rate (megabits per second) (optional)  
When Custom bit rate is selected under Bit rate options, a bit rate in megabits per second (mbps) must be 
entered. This bit rate must be equal to or greater than 1.5 mbps. A value of -1 indicates that the custom bit 
rate will be ignored during processing.  If a custom bit rate is entered, the Bit rate options parameter is 
disabled. 

 
Multiplexing Background 
The following graphic highlights a typical onboard multiplexing process using a flight computer. This is an 
example where the Esri FMV Video Multiplexer is not needed. This graphic workflow illustrates what the 
multiplexer replicates in a ground processing system. 
 
In summary, the GPS, Inertial Motion Unit (IMU) or other metadata sources, and video capture systems are 
all initiated. The Flight Computer then combines the different metadata sources and video into time-
stamped metadata. The time-stamped metadata is then combined with the video data to create a single 
transport stream.  
 
The Video Multiplexer plays the role of the Packet MUX compressor in the image below. The goal of this 
geoprocessing tool is to combine your metadata and video data into a single MISB compliant video file for 
use in the FMV add-in. 

 

  
Image Courtesy of http://www.gwg.nga.mil/misb 
 
 
FMV Video Multiplexer 
If your video imaging system does not employ an onboard computer that captures and multiplexes the 
proper metadata into the video stream to create a MISB-compliant video, you can utilize the Esri FMV 
Multiplexer tool to properly combine the metadata with the video stream. 

http://www.gwg.nga.mil/misb
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The multiplexer tool utilizes the metadata and timestamp from a GPS, IMU, video, other metadata sources 
and combines or multiplexes them together into a single MISB-compliant file. It is assumed that your system 
captures the sensor orientation information from an Inertial Measurement Unit (IMU) or similar, platform 
positional information from airborne GPS or similar, linked to a time stamp, camera field of view, focal 
length and other pertinent metadata information. This information is often stored in a CSV (comma 
separated values) file or spreadsheet. This metadata needs to be stored in a CSV or excel spreadsheet for 
input into the multiplexer tool. Please refer to the MISB Field Mappings section for more details about 
preparing metadata files for ingest into the multiplexer tool.  
 
The Video Multiplexer tool ingests all of the location information about the position and attitude of the 
aircraft and sensor, together with the timestamp information, and inserts this information into the proper 
location in the video transport stream to estimate where each video frame footprint should lay on the map. It 
is common that this metadata is inserted at intervals into the video stream, determined by the timestamp. 
For example, metadata is inserted after every 5th video frame, and the position of the video frame footprint 
on the map is interpolated from the metadata interval. 

 
The multiplexer uses video frame corner information from the metadata to display the video frame on the 
map. If video frame information is not available in the metadata, the Video Multiplexer calculates the size, 
shape and position of the video frame footprint projected onto the map utilizing a minimum set or sensor 
and collection platform position and orientation information.  
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Required fields to calculate the video frame outline 
In order to see the relative corner points of the video frame footprint as a frame outline on the map you will 
need data from the following fields. If you collect the following metadata, the FMV Video Multiplexer will 
calculate the video frame corners, and thus the size, shape and position of the video frame outline and 
display it on the map. 
 
UNIX Time Stamp: Coordinated Universal Time (UTC) represented in the number of microseconds elapsed 
since midnight (00:00:00), January 1, 1970. Derived from the POSIX IEEE 1003.1 standard. Resolution: 1 
microsecond. 
PlatformHeading: Aircraft heading angle. Relative between longitudinal axis and True North measured in 
the horizontal plane. 
PlatformPitch: Aircraft pitch angle determined by the rotation around the side-to-side axis of the collection 

platform, also described as nose up or nose down. 
 
PlatformRoll: Aircraft roll angle determined by the rotation around the front-to-back axis of the collection 
platform. This occurs when one airplane wing is higher or lower relative to the other wing. 
SensorLatitude: The latitudinal position of the sensor aboard the aircraft. Based on WGS84 ellipsoid. 
SensorLongitude: The longitudinal position of the sensor aboard the aircraft. Based on WGS84 ellipsoid 
SensorAltitude: The height above mean sea level of the sensor aboard the aircraft. 

 
Graphic courtesy of http://www.gwg.nga.mil/misb 

 
 

http://www.gwg.nga.mil/misb
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HorizontalFOV: Horizontal field of view of selected imaging sensor, in milli degrees.  
SensorRelativeAzimuth: Relative rotation angle of sensor to platform longitudinal axis. Rotation angle 
between platform longitudinal axis and camera pointing direction as seen from above the platform, in nano 
degrees. 
SensorRelativeElevation: Relative Elevation Angle of sensor to platform longitudinal-transverse plane. 
Negative angles down, in nano degrees. 
SensorRelativeRoll: Relative roll angle of sensor to aircraft platform. Twisting angle of camera about lens 
axis. Top of image is zero degrees. Positive angles are clockwise when looking from behind the camera. 

 

The graphic on the left serves to describe the relative sensor orientation while the graphic on the right 
illustrates the how the video corners are projected onto a map. Graphic courtesy of 
http://www.gwg.nga.mil/misb 

 
MISB Field Mappings 
Because commercial full motion video is a nascent industry, there is not one standard that sensor 
manufacturers adhere to. The result is that while Esri Full Motion Video needs videos to be MISB compliant, 
the camera you are using may not have organized the data to this standard. To assist you with getting your 
CSV fields in the proper structure, there is a field mapping template 
(FMV_MISB_Field_Mappings_Template.csv) which is included in the Add-In. Use this file to cross-
reference your column headings in your metadata CSV file to the MISB-compliant field names. An example 
of how to prepare your metadata for input to the multiplexer tool follows.  
 
Metadata from different sensors can take many forms depending on manufacturers of IMU and GPS 
instruments. Most output the metadata into a CSV file, XML or another file format that can be easily 
imported into a spreadsheet application such as Excel to generate a CSV file. Once the metadata is in a 
spreadsheet in CSV format it is ready to be cross referenced to the field mapping template. Getting the 
myriad of different metadata types into the proper format and mapped to the template is based on the 
procedures outlined in this document, as well as knowledge, art and intuition. With a little practice, users 
have become adept at using all these qualities to map a large variety of metadata schemes to the field 
mapping template to generate MISB-compliant video data.  
 

http://www.gwg.nga.mil/misb
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As mentioned previously, the minimum MISB fields needed to project the four corners of the video frame 
onto a map are shown in the Esri field mapping template below. Having the video frame corners enables 
you to more fully exploit the robust functionality of the FMV Add-In.  Minimum metadata information needed 
to project the four corners of the video frame onto a georeferenced map is shown below. 

A summary of the steps to multiplex a typical asynchronous metadata file with the associated video data 
stream are listed below. These steps may vary according to the type and format of your recorded metadata 
information. 

 
Steps: 

 
1. Convert GPX to CSV (https://www.gps-data-team.com/convert.php), or  
2. Convert from CSV to XML (http://www.convertcsv.com/csv-to-xml.htm)  
3. Use Excel and open the file specifically as type XML 
4. Open the MISB 0601.8 document for reference 
5. Rename columns as needed or use the Esri field mapping spreadsheet so that the column names are 

MISB compatible and ready for the Multiplexer.  
6. Convert time to Epoch time if needed. Use a website such as http://www.epochconverter.com/ to do the 

initial conversion and then use Excel to increase time values in equal increments (e.g. 1 second). 
7. Cross check and make sure you have the minimum required fields for four corner offset calculation, if 

needed: UnixTimeStamp, PlatformHeading, PlatformPitch, PlatformRoll, SensorLatitude, 
SensorLongitude, SensorAltitude, HorizontalFOV, SensorRelativeAzimuth, SensorRelativeElevation, 
SensorRelativeRoll 

8. Run the FMV multiplexer tool. 
9. Check your video with the FMV Add-in and make adjustments to the multiplexer as needed: time shifts, 

field mappings, etc. 
 
Each of these steps is explained in detail using the example case below. 
The example below is metadata in GPX format, or GPS Exchange Format, which is an XML schema 
designed as a common GPS data format for software applications, see 
https://en.wikipedia.org/wiki/GPS_Exchange_Format for more details. Since GPX is a XML format, and 
XML is imported into a spreadsheet straightforwardly, the GPX file was renamed to have an .XML file 
extension. This file was then imported to excel using the defaults to create a CSV file shown below. 

https://www.gps-data-team.com/convert.php
http://www.convertcsv.com/csv-to-xml.htm
http://www.epochconverter.com/
https://en.wikipedia.org/wiki/GPS_Exchange_Format
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Sample of metadata in GPS Exchange Format (GPX), which is an XML file 
 
The first thing to notice is that most of the basic information needed is available, and is described below. 
The MISB field names are in bold text 

 
Sensor Latitude information – contained under the lat field 
 
Sensor Longitude information – contained under the long field 

 
Sensor True Altitude information – contained under the ns1:ele field. These values looks to be the 
altitude of the platform, but we are not yet sure if this is height about ground or height above mean sea 
level, and the units (e.g., meters, feet).   
 
When viewing the video, it commenced with a close-up view of grass where the individual blades of grass 
were visible; thus it is likely that the Altitude values are above mean sea level. Sorting the ns1_ele field 
for the lowest value provides the ground elevation value used in the Video Multiplexer tool to establish the 
datum. This was verified by displaying the Esri WorldElevation - TerrainMap for the latitude/longitude 
location in ArcMap using the “Identify” tool in ArcMap. 
 
UNIX Time Stamp information – is contained in the ns1:time field. The time is not in Epoch, or UNIX, 
time so it needs to be converted. Use a website like  http://www.epochconverter.com/ to do the initial 
conversion from readable time to Epoch (UNIX) time.  

 
 Steps: 

1. Type the first timestamp record value from the spreadsheet into the Epoch time converter.   
2. Notice the timestamp on the spreadsheet – it gives an 8 hour offset from Greenwich Mean Time, 

so when you enter the date and time values into the converter, add 8 hours. 
3. The converter gives the time in milliseconds, whereas the MISB standard requires time in micro-

seconds. Add three zeros to the converter time stamp value to transform milliseconds into 
microseconds. Enter this value into a new field (column) in the spreadsheet with the field heading 
name “UNIX Time Stamp”. 

4. Select the entire UNIX Time Stamp column in the spreadsheet (without including the column 
heading, “UNIX Time Stamp”) and format the cells to “Number” with zero decimal places. You will 
see a time stamp that looks similar to 1421690042746890. 

http://www.epochconverter.com/
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5. Convert the last time stamp in the spreadsheet to Epoch time as described above and enter it in 
the appropriate cell (i.e., last record, new UNIX Time Stamp field). Thus, you now have the first 
and last Epoch UNIX timestamp values for the video. 

6. Select the entire UNIX Time Stamp column in the spreadsheet and format the cells to “Number” 
with zero decimal places. 

7. Subtract the first record UNIX Time Stamp value from the last time stamp value to derive the 
length of time of the video in Epoch UNIX time. 

8. It is common that the IMU records metadata at a regular interval. If the metadata is not 
recorded at a regular interval, use the “batch convert” option 
in  http://www.epochconverter.com/ 

9. In a separate blank cell in the spreadsheet, divide the time length of the video above by the 
number of data records to get the average time span between records. 

10. In a different blank cell in the spreadsheet, add the average time span number to the UNIX time 
stamp value in the first record.  This yields the incremental time increase between the first and 
second records (i.e., metadata packets).  The next step is necessary due to one of those quirky 
Excel things: 

11. Copy the UNIX Time Stamp value you just computed and copy it into a new cell in the 
spreadsheet with a right click, select “paste special” and choose “paste values”.  This copies the 
value of the computation rather than the formula for the value.  Next, copy this value (not the 
formula) and paste it into second record in the UNIX Time Stamp field. 

12. You now have 3 time stamp records in the UNIX Time Stamp field; the first 2 records and the last 
record.  Use the last record as a check by copying it and pasting it into a blank field. 

13. Select the first 2 records in the UNIX Time Stamp field, then select the lower right corner of your 
selection and drag all the way to the bottom of the column to the last UNIX Time Stamp record.  
This will populate the entire column with each record increased by the average time increment. 

14. Verify that the last record in the UNIX Time Stamp column is the same or very close to the value 
that you copied and pasted for verification.  

 
Platform Heading Angle information – is contained under the metadata field name of ns1:course 
 
Platform Pitch Angle information – is contained under the metadata field name of ns1:pitch 
 
Platform Roll Angle information – is contained under the metadata field name of ns1:roll 
 
Save the CSV file, which now looks like the example below. 

 

 
  
The metadata information above is the minimum needed to display the sensor position and heading on the 
ArcMap map display. Input the metadata field names from the spreadsheet into the MISB metadata 
mapping template. 

 

http://www.epochconverter.com/
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Graphic shows the sensor heading (i.e., the direction the arrow is pointing) and sensor ground track. 
 
In order to display the 4 corners of the video frame onto the map, cross reference the sensor field of view 
and relative orientation information from the CSV file to the MISB field mapping template. 
 
Sensor Horizontal Field of View – This information is usually available from the camera manufacturer. In 
this case it is 64.4. Add this value to the spreadsheet and copy it to all cells for all records. Name the field 
(i.e., column heading) Sensor Horizontal Field of View 
 
Sensor Vertical Field of View – The multiplexer can compute this value from the file properties of the 
video file, so it is often not necessary to input this value. 
 
Sensor Relative Azimuth Angle – is the direction the sensor is pointing relative to the heading of the 
platform. In this case the camera was nadir looking, i.e., pointed vertically down, so this value is 0. Add this 
value to the spreadsheet and copy it to all cells for all records. Name the field (i.e., column heading) Sensor 
Relative Azimuth Angle 
 
Sensor Relative Elevation Angle – Since the camera was pointing down, this value is -90. Add this value 
to the spreadsheet and copy it to all cells for all records. Name the field (i.e., column heading) Sensor 
Relative Elevation Angle 
 
Sensor Relative Roll Angle – Since the sensor was fixed to the imaging platform, (the sensor was not 
mounted on a gimbal) there is no relative sensor roll angle and the value is 0. 
 
Once the metadata CSV file is updated with this information and the MISB field mapping template updated 
with the information above, multiplex the video and metadata again. Once the video and metadata is 
multiplexed play the new video. If multiplexing was successful, you will see the sensor position, heading 
and four corners of the video frame displayed on the map. 
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FMV video multiplexed with metadata used to derive the 4 corners of the video frame on the map 
 
Time Shifts 
Ideally the video images and the metadata are time-synchronous. When this is the case the image footprint 
in FMV surrounds features that can be seen in the video image. However, sometimes there is a mismatch 
between the timing of the video and the timing in the metadata. This leads to an apparent time delay 
between when a ground feature is surrounded by the image footprint and when that ground feature is visible 
in the video image. If this time shift is observable and consistent, the multiplexer can adjust the timing of the 
metadata to match the video. The time shift observations file is a CSV file, FMV_Time_Shift_Template.csv, 
containing columns for elapsed time and time shift, and two data rows. A row for column names is optional. 
 
Example 1: The video image seems to lag the FMV image footprint by 5 seconds. This can be noticed near 
the beginning of the video and also near the end. The observation file would contain one line:  
 

 
The entire video is shifted 5 seconds. 
Note:  Video relative to metadata. If video lags footprint, use negative values 
 
Example 2: There is a 5 second lag at 0:18 into the video and a 9 second lag at 2:21 into the video. The 
time observation file would contain two lines. 
 

 
In this case the video is shifted differently at the beginning and end. 
Note:  Video relative to metadata. If video lags footprint, use negative values. 

 
 
 
 

  

Elapsed Time into video (days.hours:minutes:seconds) Time Shift (seconds).  

0.00:00:13 -5

Elapsed Time into video (days.hours:minutes:seconds) Time Shift (seconds).  

0.00:00:13 -5

0.00:02:13 -9
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Summary 
The Esri FMV 1.3 Add-In User’s Manual addressed many aspects of the software, including new features, 
how to uninstall older versions, installation instructions for the Add-In and the associated geoprocessing 
tools, menu map for all the functionality, and details on how to use the three main components; the video 
player, video manager and the geoprocessing tools.  A few of the more noteworthy enhancements in this 
release include the working with realtime video, the video search capability and the video multiplexer.  A lot 
of attention was given to the Multiplexer Geoprocessing Tool with special focus on the field mapping of 
metadata because it enables many types of video data with accompanying metadata to be converted for 
use in FMV Add-in. 
 
The core capability, coupled with the new FMV 1.3 features, results in a robust full motion video experience 
that is unparalleled in the commercial geospatial video industry today.   
 
For more information about Esri’s Full Motion Video Add-In, please visit the FMV Page at 
http://www.esri.com/FMV and Esri GeoNet. This FMV resource site includes, but is but not limited to,  

 Free Trial software 

 Order FMV 1.3 Add-In 

 GeoNet correspondence and info 

 User’s Manual 

 Blogs 

 Tutorials and data 

 FAQ and other customer service information 

 Presentations 
 
Your feedback on the software capability and functionality, user experience, user help, documentation and 
customer support is much appreciated. 

http://www.esri.com/FMV
https://geonet.esri.com/community/gis/imagery-and-remote-sensing/content?filterID=contentstatus%5bpublished%5d~category%5bfull-motion-video%5d

